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What is Recorder?
With Windows Recorder, you can save a sequence of keystrokes and mouse actions. This sequence is 
called a macro. By choosing the macro, you can automatically play back the sequence of keystrokes 
and mouse actions in an application.
For example, you might use a macro with Windows Write to center a paragraph. Instead of choosing 
Centered from the Paragraph menu, you might press CTRL+C, which would automatically center the 
selected paragraph.
When you first start Recorder, a blank, untitled Recorder window appears. Each macro that you record 
appears in the window:

A Recorder file consists of the macros you record. You can create, open, and save macro files as you 
would other kinds of files.



macro
A sequence of keystrokes and mouse actions that are played back automatically in an application when 
you press a particular key combination or choose the macro from the Recorder window.



A Simple Macro
To record a simple macro, you:

Place the insertion point or pointer in the application where you want the macro to begin.
Choose a macro name and shortcut key.
Type the keystrokes and take the mouse actions you want to record.
Choose the Recorder icon to stop recording.

If you are creating a simple macro, you only need to select a macro name or shortcut key.    

Before you record a complex macro involving multiple windows or applications, you should read the 
Guidelines for Creating Macros and Recorder procedures.

Related Procedure



shortcut key
In Recorder, a key combination that plays a macro.



hint
The following table summarizes the Record Macro options:

Use this option To specify
Record Macro Name The macro name that will appear in the Recorder window.
Shortcut Key The key combination that will play the macro.
Playback To Whether a macro plays only in the application in which it was recorded or in any 

application.
Speed The speed at which a macro plays.
Continuous Loop Whether a macro plays continuously.
Enable Short Keys Whether a macro can contain shortcut keys.
Record Mouse What mouse movements are recorded.
Relative to Whether a macro is recorded relative to the screen or the active window.
Description A description of what the macro does or what it is for.



Guidelines for Creating a Macro
For best results, follow these guidelines when recording macros:

Prepare for recording the macro.
If there are applications on the screen that should not be involved in the macro, close or move them 
out of the way before you start recording. Also, place the insertion point in the application where you 
want the macro to begin.

Use the mouse sparingly.
When you play a macro, the application window might be a different size and in a different location 
than when you recorded it. If so, the mouse might go outside the window's boundaries , or it might 
point at the wrong item.

Use the Windows shortcut keys rather than the arrow keys to choose menu commands.
If a window is near the bottom of the screen when you play a macro, a menu might pop up instead of 
down, making the UP ARROW and DOWN ARROW keys move the pointer inappropriately.

Be aware of system incompatibility issues.
Recorder is sensitive to screen resolution when recording mouse movements. Macros with mouse 
movements seldom work properly on a system that uses a different graphics adapter than was used 
on the system the macro was recorded on.
Recorder is also sensitive to the keyboard type and setup. It is best not to use a macro that was 
recorded using a keyboard set up for one country on a system with a keyboard set up for another 
country. See Control Panel for more information about keyboard settings.

Be aware that Recorder is designed for use with Windows applications only.
Use the ALT key sparingly when designating shortcut keys for macros.

Recorder shortcut keys using ALT could easily conflict with Windows shortcut keys.
Press CTRL+BREAK when you want to stop recording your macro if you use the Everything option 

to record keystrokes and all mouse movements.
If you use the mouse to stop recording, the movement of the mouse to the Recorder icon can cause 
the macro to behave incorrectly when played back. The Recorder icon could be in a different location,
or the window could be a different size.

When you change a nested macro, be sure not to make changes that cause the macro containing
the nested macro to stop working properly.

Since a macro that contains a nested macro records only a shortcut key, not the actual sequence of 
steps represented by the shortcut key, any nested macros can be changed at any time.



nested
Describes a macro that is used in another macro.
For example, in Windows Write, you could create a macro that selects a paragraph of text, then plays a 
macro that copies the text to the Clipboard.



How to Play a Macro
You can play a macro by pressing the Recorder shortcut key you assigned to the macro. Or, you can 
double-click the macro name in the Recorder window.

Related Procedure



How to Change a Macro
If, after recording a macro, you want to change some of the Record Macro options, you can do so with 
the Properties command. For example, you might want to change the Recorder shortcut key that plays 
the macro. You can change the options (except Relative To) in the following dialog box:

Related Procedure



Demos
In the Record Macro dialog box, Recorder has several options to help you create a demo. You might, for
instance, use a demo to teach people how to draw with Paintbrush or to display the features of Write.
The options for creating a demo include:

Continuous Loops, which makes the macro play continuously.
Use this option to create a demo that will run continuously. If you choose this option, you will need to 
press CTRL+BREAK to turn off the macro.

Recorded Speed, which lets you play a macro at the speed at which it was recorded.
Normally, Recorder plays a macro faster than you recorded it. In a demo, you might want the macro 
to play more slowly.

Control+Break Checking, which keeps the macro from being turned off by CTRL+BREAK.

Use this option to keep someone from turning off your continuously playing macro. If you choose this 
option, you will have to turn off your computer to stop the macro's playing.

Related Procedures



Procedures
Changing a Macro's Playback Speed
Playing Macros Continuously
Turning Off Ctrl+Break



How to Customize Recorder
You can change how Recorder works in a couple of ways:

Modify Recorder's standard settings with the Preferences command.
You can change where a macro can play, the play speed, what mouse movements are recorded, and 
whether a macro plays relative to window or screen.

Turn off Recorder's shortcut keys.
Select this option, for example, if you want to run an application that uses the same shortcut keys that
one of your macros uses.

Related Procedures



Procedures
Modifying Macro Settings
Turning Off Shortcut Keys













New Command

Creates a new macro file.
When you choose this command, Recorder lets you saves changes to the current file.

Related Procedure



Open Command

Opens an existing macro file.
When you choose this command, Recorder lets you save changes to the current file.

Related Procedure



Save Command

Saves changes to the current file.
When you choose this command, the file remains open so you can continue working on it.

Related Procedure



Save As Command

Saves a new macro file or an existing macro file under another name.
When you name a new or rename an existing file, if you don't specify an extension, .REC is 
automatically assigned to the filename. If you specify an extension, it overrides any automatic extension.
You might want to rename a file so that you can change an existing file without modifying the original.

Related Procedure



Merge Command

Merges two macro files.
With Merge, you can consolidate a macro file you select with the current file. Recorder clears any 
duplicate shortcut keys (but not the macros themselves) from the merged file.
Use Save As from the File menu to save the merged file under a new name. Or choose Save to save the
merged file under the current name.
Use the Delete command in File Manager if you subsequently want to delete the file you merged with 
the current file.

Related Procedures



Procedures
Deleting Files or Directories
Merging Files
Saving Existing Files
Saving New or Renaming Existing Files



Exit Command

Exits Recorder and closes the Recorder window.
If the current file is unsaved, Recorder lets you save it before exiting.



Run Command

Plays a macro.
If you have not assigned a Recorder shortcut key to a macro, you must use this command on the Macro 
menu to play the macro. You can also use this command to play a macro if you don't remember the 
shortcut key for the macro.

Related Procedure



Record Command

Records a macro.
You can specify:

A macro name, shortcut key, and description.
Whether a macro plays only in the application in which it was recorded or in any application.
The speed at which a macro plays.
Whether a macro plays continuously.
Whether a macro can contain shortcut keys.
What mouse movements are recorded.
Whether a macro is recorded relative to the screen or the active window.

When you are recording a simple macro, the standard settings for the Record options should work in 
most cases. Recording a simple macro is a straightforward, simple process. However, the Windows 
environment, which can contain multiple windows and multiple applications, can be a complex one in 
which to record a macro. It is a good idea to read the topics listed in the Related Topics before recording 
complex macros.

Related Topics



Concept
Guidelines for Creating Macros

Procedures
Changing a Macro's Playback Speed
Identifying Macros
Including Macros Within Macros
Recording Macros Relative to the Window or Screen
Recording Simple Macros
Playing Macros Continuously
Specifying What Mouse Movements to Record
Specifying Where Macros Play



Delete Command

Deletes macros from a file.
Use the Delete command in File Manager if you want to delete an entire macro file.

Related Procedures



Procedures
Deleting Files or Directories
Deleting Macros from a Recorder File



Properties Command

Changes a macro's properties or settings.
You can use the Properties command on the Macro menu to change most of the properties that you 
assigned to a macro when you recorded it. You can specify:

A macro name, shortcut key, and description.
Whether a macro plays only in the application in which it was recorded or in any application.
The macro's play speed.
Whether a macro plays continuously.
Whether a macro can contain shortcut keys.

Screen resolution information lets you know what kind of video display the macro was recorded on. This 
is helpful because mouse movements are sensitive to the screen resolution, and macros containing 
mouse movements seldom work properly on a different type of video display.

Related Procedure



Control+Break Checking Command

Turns CTRL+BREAK on or off.
Normally, you press CTRL+BREAK to stop playing a macro. With Control+Break Checking, you can 
prevent anyone from interrupting a macro, especially a continuously playing macro you might be using 
for a demo.
CTRL+BREAK is turned on when a checkmark appears next to Control+Break Checking on the Options 
menu.

Related Procedures



Procedures
Including Macros Within Macros
Turning Off Ctrl+Break



Shortcut Keys Command

Turns Recorder's shortcut keys on or off.
If you turn on shortcut keys, you can include macros within a macro you are recording. Shortcut keys are
turned on when a checkmark appears next to Shortcut Keys on the Options menu.
If you turn off shortcut keys, you prevent Recorder from detecting shortcut keys when you record a 
macro or try to play a macro.

Related Procedure



Minimize On Use Command

Minimizes the Recorder window to an icon when you play a macro.
Related Procedure



Preferences Command

Changes preferences or default settings for recording a macro.
Each time you choose the Record command, the Record Mouse, Relative To, Playback To, and 
Playback Speed recording options are set to default settings. With the Preferences command, you can 
change the following settings:

Whether a macro plays in any application or only in the application in which you recorded it.
The macro's play speed.
What mouse movements are recorded.
Whether a macro is recorded relative to the screen or the active window.

The settings you select in the Default Preferences dialog box become the standard settings for the 
appropriate options in the Record Macro dialog box. Recorder continues to use these standard settings 
until you use the Preferences command to change them again.

Related Procedure
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Recording Simple Macros
Recorder provides various options that you can set when recording complex macros. When you are 
recording a simple macro, however, the standard settings for these options should work in most cases. 
Recording a simple macro is a straightforward, simple process. However, the Windows environment, 
which can contain multiple windows and multiple applications, can be a complex one in which to record 
a macro. It is a good idea to read the topics listed in the Related Topics before recording complex 
macros.

To record a simple macro:
1 Position the insertion point in the application where you want to start recording the macro.
2 Choose Record from the Macro menu.
3 Identify the macro with a macro name, shortcut key, and/or description.

You must use either a name or shortcut key; the description is optional.
4 Specify any other options you want.

You probably do not need to change the settings for any of the other options when recording a simple 
macro.

5 Choose Start to begin recording the macro.
When you choose Start, Recorder shrinks to a flashing icon. The icon continues flashing until 
recording stops, although the icon may not be visible if you move another window in front of it.

6 Enter the keystrokes and mouse actions you want to record.
It is best to use few or no mouse actions when recording a macro. For more information, see 
Specifying What Mouse Movements to Record and Guidelines for Creating Macros in the Related 
Topics.

7 Click the Recorder icon to stop recording.
8 Select Save Macro to save your macro.

Or to resume recording where you left off, select Resume Recording.
Or to cancel recording and discard what you have recorded so far, select Cancel Recording.

9 Click OK.
Related Topics
Keyboard Procedure



Suspending Recording
To suspend recording a macro:
1 Click the Recorder icon.

Or press CTRL+BREAK.
2 Choose one of the following options:

This option Does this
Save Macro Stops recording and saves the macro.
Resume Recording Starts recording again where you left off.
Cancel Recording Cancels recording and discards what you have recorded so far.

3 Click OK.
Related Procedure
Keyboard Procedure 



Identifying Macros
You can identify a macro with a macro name, shortcut key, and/or description. You must use either a 
name or a shortcut key; the description is optional.    

To identify a macro:
In the Record Macro dialog box, select the following options you want:

This option Specifies
Record Macro Name A short macro name.

Use the name to help you remember the purpose of a macro. The name 
appears with the shortcut key on the list of macros in the Recorder window. 
If you do not want to assign a shortcut key to a macro, you must enter a 
name. A name can contain up to 40 characters.

Shortcut Key The Recorder shortcut key for playing the macro.
Use CTRL, SHIFT, or ALT with other keyboard keys. If you want to use a 
function or keypad key name in a shortcut key, select the key name from 
the drop-down list box.
CAUTION: Use ALT sparingly in Recorder shortcut keys to avoid conflicting 
with Windows shortcut keys.

Description A macro description.
If you want to record a description of the macro longer than the name, type 
a description. The Description box can contain a large amount of text.

Related Procedure
Keyboard Procedure 



hint
You should assign a shortcut key to a macro. Doing so provides an easy way of using the macro. You 
just have to press the assigned key combination, and the macro starts playing. However, if you prefer 
not to assign a shortcut key or if you run out of key combinations to use, you can type a name in the 
Record Macro Name box in the Record Macro dialog box instead.



Specifying Where Macros Play
You can play a macro in any application or only in the application in which you record it. Normally, you'll 
want to play a macro only in the application in which you recorded it. Many times, a macro that makes 
sense in one application might not make any sense in another. For example, a macro that types a long 
phrase that you use frequently might be appropriate for your word processor, but not for your 
spreadsheet.

To specify where a macro plays:
1 In the Record Macro dialog box, select the Playback To box.
2 Select Same Application or Any Application.

Keyboard Procedure 



Changing a Macro's Playback Speed
Recorder provides certain options for demonstrating features or applications. For instance, you can have
a macro play at a speed appropriate for a demonstration. (If you want a demonstration to play 
continuously, see Playing Macros Continuously.)

To change a macro's playback speed:
1 In the Record Macro dialog box, select the Playback Speed box.
2 Select Fast or Recorded Speed.

Normally, you'll want to play a macro quickly. However, if you are going to use a macro in a 
demonstration, you'll probably want the macro to play at the same speed at which it was recorded.

Related Procedure
Keyboard Procedure 



Playing Macros Continuously
Recorder provides certain options for demonstrating features or applications. For instance, you can set a
demonstration to play continuously until you turn off your computer. (If you want demonstration to play at
its recorded speed instead of at a fast speed, see Changing a Macro's Playback Speed).

To set a macro to play continuously:
In the Record Macro dialog box, select the Continuous Loop check box

Use CTRL+BREAK to stop a continuously playing macro. If you want to prevent a continuously running 
demonstration from being turned off by CTRL+BREAK, see Turning Off   CTRL+BREAK  .

Related Procedures
Keyboard Procedure 



Procedures
Changing a Macro's Playback Speed
Turning Off CTRL+BREAK



Including Macros Within Macros
Recorder allows you to include--or nest--up to five levels of macros within a macro. In other words, 
Macro 1 can contain a macro called Macro 2, Macro 2 can contain a macro called Macro 3, and so on.

To include macros within a macro:
1 Make sure Shortcut Keys is checked in the Options menu.
2 Choose Record from the Macro menu and select the Enable Shortcut Keys check box.
3 Record the macro.

When recording the macro, press the macro shortcut key(s) when appropriate.
CAUTION: Since a macro that contains a nested macro records only a shortcut key, not the actual 
sequence of steps represented by the shortcut key, any nested macros can be changed at any time. 
When you change a nested macro, you must be sure not to make changes that cause the macro 
containing the nested macro to stop working properly.

Related Procedures
Keyboard Procedure 



Specifying What Mouse Movements to Record
Although Recorder allows you to record as many mouse movements as you want, you should keep the 
recording of mouse movements to a minimum. Macros that record keystrokes are generally more 
reliable. This is because mouse movements that you record in one window might not be appropriate for 
the window in which you later want to play the macro, particularly if the windows are not the same size.

To specify what mouse movements to record:
1 In the Record Macro dialog box, select the Record Mouse box.
2 Select an option.

This option Records
Ignore Mouse Only keystrokes.

Select this option when the macro will be used on a variety of machines. Macros 
with mouse movements will work properly only on machines using a video 
display identical to the one used by the system in which the macro was recorded.

Everything Keystrokes and all mouse actions even when a button is not pressed.
Use this option sparingly. It is appropriate, however, when you are using an 
application that pays attention to mouse movements even when no button is 
pressed.

Clicks+Drags Keystrokes and all mouse actions that occur while a button is pressed.
With this setting, you can record most drawing or editing sequences in a program
such as Paintbrush.

CAUTION: If you use the Everything option to record keystrokes and all mouse movements, press 
CTRL+BREAK when you want to stop recording the macro. If you use the mouse to stop recording, the 
movement of the mouse to the Recorder icon can cause the macro to behave incorrectly when played 
back. The Recorder icon could be in a different location, or the Window could be a different size.

Keyboard Procedure 



Recording Macros Relative to the Window or Screen
Normally, you'll want to record a macro relative to the window you are currently working in. Sometimes, 
however, you might want to record a macro relative to the entire screen. For example, you might be 
using a full-screen application.

To record a macro relative to the window or the entire screen:
1 In the Record Macro dialog box, select the Relative To box.
2 Select Screen or Window.

The Relative To option that you use to record a macro is the same option used to play the macro. You
cannot change this option after the macro is recorded.

Keyboard Procedure 



Turning Off CTRL+BREAK

Pressing CTRL+BREAK usually stops the recording or playing back of a macro. If you want to use a macro 
as a continuously running demonstration, you might want to turn off Recorder's ability to detect 
CTRL+BREAK so that you can prevent the demonstration from being turned off by anyone who uses the 
keyboard. The macro runs until you turn off the computer.

To turn off CTRL+BREAK:
Choose Control+Break Checking from the Options menu.

CTRL+BREAK is turned off when a checkmark does not appear next to Control+Break Checking on the 
Options menu.
To turn on CTRL+BREAK, choose Control+Break Checking again.
If you turn off CTRL+BREAK, you must restart your computer to stop a continuously playing macro.
The next time you start Recorder after turning off Control+Break Checking, the command is again set 
to detect CTRL+BREAK.

Related Procedure
Keyboard Procedure 



hint
You might also want to turn off Recorder's ability to detect CTRL+BREAK if you want to include CTRL+BREAK
in a macro.



Changing Default Settings for Recording Macros
Each time you choose the Record command, the Record Mouse, Relative To, Playback To, and 
Playback Speed recording options are set to Recorder's default settings.

To change default settings:
1 Choose Preferences from the Options menu.
2 Choose the down arrow to the right of the default setting you want to change.
3 Select the settings you want.

This setting Specifies
Playback To Whether the macro plays in any application or only in the application in which it 

was recorded.
Playback Speed Whether the macro plays at the recorded speed or faster than the recorded 

speed.
Record Mouse What mouse movements are recorded.
Relative To Whether the macro is recorded relative to the screen or the window.

4 Click OK.
The settings you select in the Default Preferences dialog box become the standard settings for the 
appropriate options in the Record Macro dialog box. Recorder continues to use these standard 
settings until you use the Preferences command to change them again.

Related Procedure
Keyboard Procedure 



Playing Macros
You must only start the macro when and where it will work properly. (Click        for an example.) When 
you start a macro that plays only in the application in which you recorded it, Recorder makes the open 
application window the active window. However, if the application hasn't been started or has been 
minimized to an icon, Recorder cancels the macro.

To play a macro with a shortcut key:
1 Open the Recorder file that contains the macro.
2 Position the insertion point or cursor in the application where you want the macro to play.
3 Press the Recorder shortcut key assigned to the macro.

If you have not assigned a shortcut key to a macro, you must use the Run command on the Macro menu
to play back the macro. You can also use this command to play back a macro if you don't remember the 
shortcut key for the macro.

To play a macro with the Run command:
1 Open the Recorder file that contains the macro.
2 Position the cursor where you want the macro to play.
3 Switch to the Recorder window.
4 Select the macro and choose Run from the Macro menu.

Or double-click the macro.
Related Procedures
Keyboard Procedure 



Procedures
Minimizing Recorder When Playing Macros
Stopping Macros



example
Suppose you want to play a macro that automatically enters and sets an alarm for a standing 
Wednesday-afternoon appointment. Such a macro would not be appropriate to use in any application 
except Calendar.



Minimizing Recorder When Playing Macros
When you start playing a macro using the Run command, you can have the Recorder window shrink to 
an icon.

To shrink Recorder to an icon:
Choose Minimize On Use from the Options menu.

A checkmark appears next to the command name on the menu.
Choose Minimize On Use again to turn off the command and keep the Recorder window in its position
on the screen while the macro plays.

Related Procedure
Keyboard Procedure 



Stopping Macros
To stop playing a macro:
1 Press CTRL+BREAK.
2 Click OK to close the Recorder Playback Aborted message box.

Related Procedure
Keyboard Procedure 



Turning Off Shortcut Keys
Use the Shortcut Keys command when you want to run an application that uses the same shortcut key 
that one of your macros uses.

To turn off Recorder's shortcut keys:
Choose Shortcut Keys from the Options menu.

Shortcut keys are turned off when a checkmark does not appear next to Shortcut Keys on the Options
menu.
Choose Shortcut Keys again to restore Recorder's shortcut keys.
The next time you start Recorder, the Shortcut Keys command is automatically turned on.

Related Procedures
Keyboard Procedure 



Modifying Macro Settings
You can use the Properties command on the Macro menu to change most of the properties that you 
assigned to a macro when you recorded it.

To modify a macro's settings:
1 Select the macro from a file.
2 Choose Properties from the Macro menu.
3 Change any of the following settings:

This setting Specifies
Macro Name A short macro name.
Shortcut Key The shortcut key used to play the macro.
Description A macro description.
Playback To Whether the macro plays in any application or only in the application in 

which it was recorded.
Playback Speed Whether the macro plays at the recorded speed or faster than the 

recorded speed.
Continuous Loop Whether the macro plays continuously.
Enable Shortcut Keys Whether the macro can contain other shortcut keys.

4 Click OK.
The screen resolution information lets you know what kind of video display the macro was recorded 
on. This is helpful because mouse movements are sensitive to the screen resolution, and macros 
containing mouse movements seldom work properly on a different type of video display.

Related Procedures
Keyboard Procedure 



Procedures
Changing Default Settings for Recording Macros
Deleting Macros from a Recorder File



Creating New Files
To create a new file:

Choose New from the File menu.
Related Procedure
Keyboard Procedure 



Opening Existing Files
To open a file:
1 Choose Open from the File menu.
2 If the file is in the current directory, double-click the name of the file in the Files box.

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
double-click the name of the file in the Files box.    

Related Procedures
Keyboard Procedure 



Procedures
Browsing Through the Directories List Box
Creating New Files



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the files and directories located one level closer to a disk's root directory.
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and click OK.



Saving Existing Files
Use the Save command to save changes to an existing file.

To save an existing file:
Choose Save from the File menu.
Related Procedure
Keyboard Procedure 



Saving New or Renaming Existing Settings Files
To save a new file or to save an existing file under a different name:
1 Choose Save As from the File menu.
2 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
The .REC extension is automatically assigned to the filename if you don't specify an extension. If you 
specify an extension, it overrides any automatic extension.
If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

3 Click OK.    
Related Procedure
Keyboard Procedure 



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and click OK.



Merging Files
If you want to consolidate two Recorder files, you can do so by merging a second Recorder file into the 
current file.

To merge two files:
1 Open or create one of the files.
2 Delete macros that are duplicated in the file you want to merge.
3 Choose Merge from the File menu.
4 If the file is in the current directory, double-click the name of the file in the Files box.

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
double-click the name of the file in the Files box.    

5 Click OK if you receive a warning message about duplicate shortcut keys.
Recorder clears duplicate shortcut keys (but not the macros themselves) from the merged file. Use 
the Properties command to assign new shortcut keys to macros that had their shortcut keys cleared.

6 To save the merged file under a new name, choose Save As from the File menu .
To save the merged file under the current name, choose Save .

Related Procedures
Keyboard Procedure 



Procedures
Browsing Through the Directories List Box
Saving Existing Files
Saving New or Renaming Existing Files



Deleting Macros from a Recorder File
To delete a macro from a file:
1 Open the Recorder file.
2 Select the macro.
3 Choose Delete from the Macro menu.
4 Click OK to confirm the deletion.

Related Procedures
Keyboard Procedure 



Procedures
Modifying Macro Settings
Recording Simple Macros





To stop Press

Recording or replaying a macro CTRL+BREA
K
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Turning Off Shortcut Keys
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Creating New Files
Opening Existing Files
Saving Existing Files
Saving New or Renaming Existing Files
Merging Files
Deleting Macros from a Recorder File



Keyboard: Recording Simple Macros
To record a simple macro:
1 Position the insertion point in the application where you want to start recording the macro.
2 Press ALT and then M.
3 Press C.
4 Identify the macro with a macro name, shortcut key, and/or description.
5 Specify any other options you want.
6 Press ENTER to begin recording the macro.
7 Enter the keystrokes and mouse actions you want to record.
8 Press CTRL+BREAK to stop recording.
9 Press the UP ARROW key and press ENTER to save your macro.

Or press ENTER to resume recording where you left off.
Or press the DOWN ARROW key and press ENTER to cancel recording and discard what you have 
recorded so far.

Mouse Procedure 



Keyboard: Suspending Recording
To suspend recording a macro:
1 Press CTRL+BREAK.

2 Press the UP ARROW key and press ENTER to save your macro.
Or to resume recording where you left off, press ENTER.
Or to cancel recording and discard what you have recorded so far, press the DOWN ARROW key and 
press ENTER.

Related Procedure
Mouse Procedure 



Keyboard: Identifying Macros
To identify a macro:
1 In the Record Macro dialog box, type a macro name in the Record Macro Name text box if you want 

to specify a name.
2 Press TAB and type a key for your shortcut key, if you want one.

Or press TAB and use the UP ARROW or DOWN ARROW key to specify a function or keypad key name.
3 Press TAB until you select a key (CTRL, SHIFT, and/or ALT) you want as part of your shortcut key. Then 

press the SPACEBAR.
4 Press ALT+D and type a description of your macro, if you want to add a description.

Related Procedure
Mouse Procedure 



Keyboard: Specifying Where Macros Play
To specify where a macro plays:
1 In the Record Macro dialog box, press ALT+P.
2 Use the UP ARROW or DOWN ARROW key to select Same Application or Any Application.

Mouse Procedure 



Keyboard: Changing a Macro's Playback Speed
To change a macro's playback speed:
1 In the Record Macro dialog box, press ALT+P and then TAB.
2 Use the UP ARROW or DOWN ARROW key to select Fast or Recorded Speed.

Related Procedure
Mouse Procedure 



Keyboard: Playing Macros Continuously
To set a macro to play continuously:
1 In the Record Macro dialog box, press ALT+P.
2 Press TAB until you select Continuous Loop.
3 Press the SPACEBAR to select the Continuous Loop check box.

Related Procedures
Mouse Procedure 



Procedures
Changing a Macro's Playback Speed
Turning Off CTRL+BREAK



Keyboard: Including Macros Within Macros
To include macros within a macro:
1 Press ALT and then O.
2 Press S if Shortcut Keys is not checked.

Or press ALT if Shortcut Keys is checked.
3 Press ALT and then M.
4 Press C.
5 Press ALT+P.
6 Press TAB until you select Enable Shortcut Keys.
7 Press the SPACEBAR to select the Enable Shortcut Keys check box.

Related Procedure
Mouse Procedure 



Keyboard: Specifying What Mouse Movements to Record
To specify what mouse movements to record:
1 In the Record Macro dialog box, press ALT+M.
2 Use the UP ARROW or DOWN ARROW key to select Ignore Mouse, Everything, or Clicks+Drags.

Mouse Procedure 



Keyboard: Recording Macros Relative to the Window or Screen
To record a macro relative to the window or the entire screen:
1 In the Record Macro dialog box, press ALT+R.
2 Use the UP ARROW or DOWN ARROW key to select Screen or Window.

Mouse Procedure 



Keyboard: Turning Off CTRL+BREAK

To turn off CTRL+BREAK:
1 Press ALT and then O.
2 Press C.

Related Procedure
Mouse Procedure 



Keyboard: Changing Default Settings for Recording Macros
To change default settings:
1 Press ALT and then O.
2 Press P.
3 Press TAB until you select the drop-down list box of a default setting you want to change.
4 Use the UP ARROW or DOWN ARROW key to select the settings you want.
5 Press ENTER.

Related Procedure
Mouse Procedure 



Keyboard: Playing Macros
To play a macro with a shortcut key:
1 Open the Recorder file that contains the macro.
2 Position the insertion point or cursor in the application where you want the macro to play.
3 Press the shortcut key assigned to the macro.

To play a macro with the Run command:
1 Open the Recorder file that contains the macro.
2 Position the insertion point in the application where you want the macro to play.
3 Switch to the Recorder window.
4 Use the UP ARROW or DOWN ARROW key to select the macro.
5 Press ALT and then M.
6 Press R.

Related Procedures
Mouse Procedure 



Procedures
Minimizing Recorder When Playing Macros
Stopping Macros
Switching Among Application Windows



Keyboard: Minimizing Recorder When Playing Macros
To shrink Recorder to an icon:
1 Press ALT and then O.
2 Press M.

Related Procedure
Mouse Procedure 



Keyboard: Stopping Macros
To stop playing a macro:
1 Press CTRL+BREAK.
2 Press ENTER to close the Recorder Playback Aborted message box.

Related Procedure
Mouse Procedure 



Keyboard: Turning Off Shortcut Keys
To turn off Recorder's shortcut keys:
1 Press ALT and then O.
2 Press S.

Related Procedure
Mouse Procedure 



Keyboard: Modifying Macro Settings
To modify a macro's settings:
1 Use the UP ARROW or DOWN ARROW key to select the macro from a file.
2 Press ALT and then M.
3 Press P.
4 Press TAB until you select a setting you want to change.
5 Change the setting.
6 Press ENTER.

Related Procedures
Mouse Procedure 



Procedures
Changing Default Settings for Recording Macros
Deleting Macros from a Recorder File



Keyboard: Creating New Files
To create a new file:
1 Press ALT and then F.
2 Press N.

Related Procedure
Mouse Procedure 



Keyboard: Opening Existing Files
To open a file:
1 Press ALT and then F.
2 Press O.
3 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

4 Press ENTER.    
Related Procedure
Mouse Procedure 



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the files and directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Saving Existing Files
Use the Save command to save changes to an existing file.

To save an existing file:
1 Press ALT and then F.
2 Press S.

Related Procedure
Mouse Procedure 



Keyboard: Saving New or Renaming Existing Files
To save a new file or to save an existing file under a different name:
1 Press ALT and then F.
2 Press A.
3 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Press ENTER.    
Related Procedure
Mouse Procedure 



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Merging Files
To merge two files:
1 Open or create one of the files.
2 Delete macros that are duplicated in the file you want to merge.
3 Press ALT and then F.
4 Press M.
5 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

6 Press ENTER.    
7 Press ENTER if you receive a warning message about duplicate shortcut keys.
8 Choose Save As from the File menu to save the merged file under a new name.

Or choose Saves to save the merged file under the current name.
Related Procedures
Mouse Procedure 



Procedures
Browsing Through the Directories List Box
Saving Existing Files
Saving New or Renaming Existing Files



Keyboard: Deleting Macros from a Recorder File
To delete a macro from a file:
1 Open the Recorder file.
2 Use the UP ARROW or DOWN ARROW key to select the macro.
3 Press ALT and then M.
4 Press D.
5 Press ENTER to confirm the deletion.

Related Procedures
Mouse Procedure 



Procedures
Modifying Macro Settings
Recording Simple Macros







Recorder
An application that saves a sequence of keystrokes and mouse actions. This sequence is called a 
macro. The keystrokes and mouse actions are played back automatically in an application when you 
press a particular key combination or choose the macro from the Recorder window.



application Control-menu



title bar          
Contains the title of the application running in the window, in this case Recorder.

Drag the title bar to move the window.



Minimize button          
Click the Minimize button to shrink the Recorder window to an icon.



Maximize button          
Click the Maximize button to enlarge the Recorder window to its maximum size.



File Menu



Macro Menu



Options Menu



Help Menu



menu bar          
Contains the names of all the Recorder menus.

Click a menu name to display commands.



scroll arrow          

An arrow on either end of a scroll bar used to move the contents of the window or list box into view.
Click a scroll arrow to move the contents into view.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box for moving the contents of the window or list 
box.

Click a scroll bar to move the contents one screen.



scroll box          

A box used to move quickly to a particular location in a file or list.
Drag the scroll box to move to another location.



macro          
A sequence of keystrokes and mouse actions that are played back automatically in an application when 
you press a particular key combination or choose the macro from the Recorder window.

To play the macro, press the key combination or double-click the macro in the Recorder window.



macro          
A sequence of keystrokes and mouse actions that are played back automatically in an application when 
you press a particular key combination or choose the macro from the Recorder window.

To play the macro, press the key combination or double-click the macro in the Recorder window.



macro          
A sequence of keystrokes and mouse actions that are played back automatically in an application when 
you press a particular key combination or choose the macro from the Recorder window.

To play the macro, press the key combination or double-click the macro in the Recorder window.



application window
The main window for an application, in this case the Recorder window. The Recorder application window
can contain macros and macro names you specify.



window border          
The outside edge of a window.

Drag the window border to change the size of the window.







A
386 enhanced mode
active
active printer
animation
application
application icon
application window
arrow keys
associate
AUTOEXEC.BAT



B
<< button
>> button
Back button
base-level synthesizer
batch file
baud rate
bitmap
branch
browse
byte



C
cascading menu complementary color
CD-ROM compound device
channel CONFIG.SYS
check box Contents button
choose Control menu
Clipboard Control-menu box
close conventional memory
collapse cutout
command
command button
command line



D
data bits Directory Tree window
default button directory window
default printer disk-drive icon
desktop display box
desktop pattern document
destination directory document file
device contention document window
device driver DOS
dialog box drag
directory path drop-down list box
Directory Tree



E
error-checking
expand
expanded memory
extended memory
extended synthesizer
extension



F
file
file information line
flow control
font
font size
format
full-screen application



G
General MIDI Mode standard
group
group icon
group window



H
History button
hotspot
hue
HyperGuide button bar



I
icon
insertion point
International MIDI Association



J
No defined terms.



K
keymaps
keyword
kilobyte



L
list box
local printer
local queue
luminosity



M
maximize MIDI Mapper
Maximize button MIDI sequencer
Media Control Interface MIDI Manufacturer's Association (MMA)
memory minimize
menu Minimize button
menu bar movie file
menu command MSCDEX
menu name multimedia extensions
menu title Multimedia PC
MIDI multitasking
MIDI file



N
network printer
network queue
network server
non-Windows application



O
open
option button



P
parity print option
palette printer-driver file
patch printer font
patchmaps printer queue information line
pathname program file
picture elements program information file (PIF)
pixels program item
playlist program item icon
pointer
port



Q
No defined terms.



R
RGB components
read-only
real mode
Restore button
root directory



S
sample serial port
saturation shortcut key
scaled font size shrink
screen font simple device
screen saver solid color
scroll arrow source directory
scroll bar spin box
scroll box standard mode
Search button status bar
select stop bits
selection cursor synthesizer



T
Task List
text box
text file
title
title bar
topic
track



U
Up button



V
vector font
virtual memory
volume label



W
waveform
WAVE format
wildcard characters
window
window border
Windows application
wrap



X
No defined terms.



Y
No defined terms.



Z
No defined terms.



386 enhanced mode
Provides access to the virtual memory capabilities of the Intel 80386 processor. With virtual memory 
capabilities, Windows applications can use more memory than is physically available. Enhanced mode 
also allows for multitasking of non-Windows applications.



active
Describes the selected window or icon that you are currently working with. Windows always applies the 
next keystroke or command you choose to the active window. If a window is active, it appears in front of 
all other windows on the desktop, and its title bar changes color to differentiate it visually from other 
windows. If an icon is made active, its Control menu appears.
Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



active printer
An installed printer that has been assigned to a printer port using Setup or Control Panel. More than one
printer can be set up to work on a single port, but only one can be active, since only one printer can be 
physically connected to the port at a time.
An inactive printer is an installed printer that is not currently connected to the printer port.



animation
The display of a series of graphic images, simulating motion. You can play animation files (for example, 
files with the.MMM extension) with the Media Player accessory. Animations are also called movies.



application
A computer program used for a particular kind of work, such as word processing. This term is often used
interchangeably with "program."



application icon          

An icon that represents an application that is running.



application window
The main window for an application. It contains the application's menu bar and main workspace. An 
application window may contain multiple document windows.



arrow keys          

The four arrow keys on your computer keyboard. These keys move the cursor or pointer on your screen 
to locations you choose. Each arrow key moves the cursor or pointer in the direction of the arrow on the 
key. Each arrow key is named for the direction in which arrow points: UP ARROW, DOWN ARROW, LEFT 
ARROW, and RIGHT ARROW.



associate
To assign files that have the same extension to a program. When you choose a file with the specified 
extension, the associated application runs with the file loaded.



AUTOEXEC.BAT
Batch file that lists MS-DOS commands. MS-DOS automatically carries out the commands in your 
AUTOEXEC.BAT file when you turn on your computer. The file is located in the root directory of your first
hard disk, which is usually drive C.
Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a network and sets up 
environment variables that are used later by applications. In addition, your AUTOEXEC.BAT file might 
set your MS-DOS prompt or start pop-up programs such as Borland's SideKick.



<< button          

Displays the previous topic in a series of topics, until you reach the first topic in the series. Then the 
button is dimmed. Use this button when you want to backtrack through topics the way they are 
organized in HyperGuide.



>> button          

Displays the next topic in a series of topics, until you reach the last topic in the series. Then the button is
dimmed. Use this button to move from topic to topic in the recommended order.



Back button          

Displays the last topic you viewed. HyperGuide moves back one topic at a time, in the order in which 
you viewed them.



base-level synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



batch file
A file that runs a sequence, or "batch," of commands when you type its filename. All filenames of batch 
files end with the extension .BAT, even though you don't have to type this extension to run the batch file.



baud rate
Signalling speed measured by the number of signals per second.



bitmap          

An image stored as an array of bits.



branch          

A segment of the Directory Tree, representing a directory and any subdirectories it contains.



browse
To look through files and directories. In some dialog boxes, the Browse button shows a list of files and 
directories from which you can choose.



byte
The amount of memory space (normally 8 bits) that a computer needs to represent a single character or 
word.



cascading menu          

A menu that opens from a command on another menu.



CD-ROM
Compact Disc-Read Only Memory. An optical data-storage technology that allows large quantities of 
data (such as animations, images, music, and sound) to be stored on a compact disc similar to discs 
used by the music industry.



channel
MIDI uses channels to send messages to individual devices within a MIDI setup. There are 16 MIDI 
channel numbers. Devices in a MIDI setup can be directed to respond only to messages marked with a 
channel number specific to the device.



check box           

A small square box that appears in dialog boxes and can be selected or cleared. When the check box is 
selected, an X appears in the box.



choose
To use key combinations or your mouse to carry out a command in Windows. You often choose a 
command after you have selected an item or made it active.



Clipboard          

A temporary storage area in memory, used to transfer information. You can cut or copy information onto 
the Clipboard and then paste it into another document or application.



close
To reduce a document window or application window to an icon or, in some cases, to remove it from the 
desktop. You close a window by double-clicking the Control-menu box or choosing the Close command 
from the Control menu. When closing an application window, you can choose to save or abandon 
changes to the current document before you close it.



collapse
To hide a level of directory information in the Directory Tree window. When you first start File Manager, 
all directories but the root directory are collapsed.



command          

A word or phrase, usually found in a menu, that you choose to carry out an action.



command button          

A button in a dialog box that carries out or cancels the selected action. Two common command buttons 
are OK and Cancel. The button that carries out the action will often have a label that describes it (for 
example, Open, Create, Install). Another dialog box appears when you choose a command followed by 
ellipses.



command line
Information given to MS-DOS that specifies a command and all the pertinent information to carry it out. 
For example, to start Windows, you type win at the MS-DOS prompt.



complementary color
The color exactly opposite a color on the RGB color wheel. For example, the complementary color of 
blue is yellow.



compound device
Devices, such as the waveform audio driver, that have an associated file and require a filename 
specification when opened.



CONFIG.SYS
A file that defines device drivers and specifies your MS-DOS configuration. For example, a typical 
CONFIG.SYS file might specify the location of the MS-DOS file COMMAND.COM, define an extended 
memory manager, and specify how many files an application can have open at once. MS-DOS runs the 
commands in the CONFIG.SYS file each time you turn on your computer. Your CONFIG.SYS file is 
located in the root directory of your first hard disk, which is usually drive C.



Contents button          

Displays the HyperGuide contents.



Control menu          

The menu in the upper-left corner of a window. The Control menu appears on every application that runs
in a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.
Control menu commands move, change the size of, and close windows. You can also switch to Task List
by using the Control menu. For non-Windows applications, Control menu commands transfer 
information and perform other functions, depending on the application.



Control-menu box
The box located in the upper-left corner of a window. Clicking the Control-menu box opens the Control 
menu for the window.



conventional memory
The first 640K of memory that MS-DOS uses to run applications. Most computers have at least 256K of 
conventional memory and can accommodate up to 640K of conventional memory.



cutout          
A portion of a Paintbrush drawing you select with the Scissors or Pick tool.



data bits
The bits in each package of data sent between two computers during telecommunication. Most 
characters are transmitted in 7 or 8 data bits.



default button          

The command button in some dialog boxes that is automatically selected or chosen by Windows as the 
most logical or safest choice. The default button has a bold border, indicating that it will be chosen if you 
press ENTER. You can override a default button by choosing Cancel or another command button.



default printer
The printer that Windows applications automatically use when you choose the Print command. You can 
have only one default printer, which must also be the active printer on the port. The printer you use most 
often should be made the default printer.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



desktop pattern
A geometric pattern that appears across your desktop. You can design your own pattern or choose one 
of the patterns provided by Windows.



destination directory
The directory to which you intend to copy or move one or more files.



device contention
When several applications simultaneously request use of a peripheral device, such as a printer or 
modem.
Windows automatically handles device contention when all the applications are Windows applications. 
When one of the applications is a non-Windows application, however, the conflict is handled according 
to the options you select in the 386 Enhanced dialog box. This dialog box appears when you choose the 
386 Enhanced icon in Control Panel.



device driver
Tells Windows how to control a piece of hardware. Using Control Panel, you can install device drivers for
your:

Display (monitor)
Keyboard
Mouse
Network



dialog box          

A rectangular box that either requests or provides information. Many dialog boxes present options that 
you must choose from before Windows can carry out a command. Some dialog boxes present warnings 
or explain why a command can't be completed.



directory path          

The directions to a directory or file within your system.
In the illustration, C:\ART stands for the ART directory on drive C. Any commands you use affect the files
and subdirectories in this directory.
When you want to specify a file, make sure the filename follows the directory path.



Directory Tree          

A graphic display of a disk's directory structure. The directories on the disk are shown as branching from
the disk's root directory.



Directory Tree window          

A File Manager window that shows the complete branching structure of the selected disk drive.



directory window          

A File Manager window that lists the contents of a specific directory. The directory window shows all the 
files and subdirectories contained in the directory.



disk-drive icon          

An icon in the Directory Tree window of File Manager that represents a disk drive on your system. 
Different icons depict floppy disk drives, hard disk drives, RAM drives, CD-ROM drives, and network disk
drives.



display box          

A display box is not an option, but a type of text box that shows an example of another option you have 
selected, in this case a sample of the 10 pt, underlined, Helvetica font.



document
Whatever you create with an application, including information you enter, edit, view, or save. A document
can be a business report, a spreadsheet, a picture, and so on.



document file          

Files that are associated with an application. You can start an application and open the associated file by
choosing a document file icon.



document window          

A window inside an application window. Each document window contains a single document or other 
data file. There can be more than one document window inside an application window.



DOS
Disk Operating System, typically known as MS-DOS (Microsoft) or PC-DOS (IBM). This is the underlying
software that must exist for your PC to operate.



drag
A mouse move. You drag a Windows element by pointing to it, holding down the mouse button, and 
sliding the mouse from one spot on the surface of your desk to another and releasing the mouse button.



drop-down list box
A list box that opens and closes in dialog boxes.
Before you open a drop-down list box, it looks like this:

After the list box is open, it looks like this:

NOTE: When the list is longer than the box, scroll bars are provided.



error checking
A method for validating transmissions.



expand
To show hidden directory levels in the Directory Tree. With File Manager, you can expand a single 
directory level, one branch of the Directory Tree, or all branches at once.



expanded memory
Memory in addition to conventional memory that is available to applications. It is allocated in 16K blocks.
Windows makes use of expanded memory only if the /r switch is used at startup. Windows running in 
386 enhanced mode simulates expanded memory for the applications that need it. Windows running in 
standard mode or 386 enhanced mode allows applications to use expanded memory, but does not use 
expanded memory itself in managing applications.



extended memory
Memory in addition to conventional memory that is not readily accessible to MS-DOS or MS-DOS 
applications. Extended memory cannot be used on 8086 and 8088 computers. Windows running in 
standard mode or 386 enhanced mode uses extended memory to manage and run applications.



extended synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



extension
Part of a file or directory name that appears after a period and provides additional information. It usually 
indicates the type of file or directory. For example, program files have default extensions of .COM 
or .EXE .
Many applications include a default extension automatically when you save a file the first time. For 
example, Notepad adds a .TXT extension to all filenames unless you specify otherwise.



file
A document or application that has been given a name. All documents are stored as files in Wiindows.



file information line          

Information specific to each file in a print queue. The information can include these details:
The file's position in the queue or a printer icon if the file is printing.
The title of the print job assigned by the application (if your network software supports this).
What percentage of the file has printed so far.
The size of the file in kilobytes (if the Print File Size command on the View menu is selected).
The time and date you sent the file to Print Manager (if the Time/Date Sent command on the View

menu is selected).
If you are connected to a network printer, the printer queue information line shows the network server 
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



flow control
The method for controlling the flow of information.



font          
A graphic design applied to all numerals, symbols, and characters in the alphabet. A font usually comes 
in different sizes and provides different styles, such as bold, italic, and underlining for emphasizing text.



font size
The height of a printed character, measured in points. One inch equals 72 points. For example, 12-point 
Helv is 12 points high.

The font and font size you use determine the amount of text that fits on one page. 



format
(1) The appearance of text on the pages of a document. (2) To prepare a disk so it can hold information. 
Formatting a disk erases all information that was previously on it.



full-screen application
A non-Windows application that uses the entire screen--rather than a window--to run in the Windows 
environment.



General MIDI Mode standard
A MIDI specification controlled by the MIDI Manufacturers Association (MMA). The purpose of this 
specification is to enable MIDI file authors to create files that sound the same across a variety of 
different synthesizers.



group
A collection of applications within Program Manager. Grouping your applications makes them easier to 
find.



group icon          

A group window you have reduced to an icon in Program Manager.



group window          

A window that displays the items in a group within Program Manager. These items can be applications, 
files associated with applications, or a combination of both.



History button        

Displays a list of the HyperGuide topics you have viewed. Use this button to revisit any of the last 40 
HyperGuide topics you have viewed. The most recent topic appears first.



hotspot
Text, graphics, or parts of graphics that provide links to other HyperGuide topics or more information 
about the current topic.
Whether text or graphics, the pointer changes to the shape of a hand whenever it is over a hotspot. If 
you click a hotspot that is linked to another topic, that topic will appear in the HyperGuide window. If the 
hotspot is linked to more information, HyperGuide displays the information in a popup window on top of 
the HyperGuide window.



hue
The position of a color along the color spectrum.



HyperGuide button bar          
Contains the HyperGuide buttons you use to move among topics and contents screens. It is located 
near the top of the HyperGuide window.



icon          

A graphic representation of a disk drive, directory, group, application, document, and so on. You can 
restore an application icon to a window when you want to use the application.



insertion point          
The place where text will be inserted when you type.The insertion point usually appears as a flashing 
vertical bar in an application's window or in a dialog box. The text you type appears to the left of the 
insertion point, which moves to the right as you type.



International MIDI Association (IMA)
The non-profit MIDI organization that circulates information about the MIDI specification.



keymaps
Percussion instruments are key-based--each note plays a different percussion instrument. Keymaps 
translate MIDI key values to ensure the proper percussion instruments are used to play MIDI files. All 
MIDI files for Windows are authored using standard key assignments based on the General MIDI Mode 
standard.



keyword
Words in the HyperGuide Search dialog box that are associated with topics. Each application's 
documentation has its own keyword list, including the glossary words in HyperGuide. You select from the
list of keywords or type a keyword to see the list of topics associated with that keyword.



kilobyte
The measurement used for the size of a computer's memory, where 1 kilobyte (K) = 1,024 bytes.



list box          

A box within a dialog box that lists available choices--for example, the list of all available files in a 
directory. If all the choices don't fit in the box, there will be a vertical scroll bar to the right of the list box. 
In some list boxes, you can select more than one item.



local printer
A printer that is directly connected to your printer by a cable.



local queue          

Lists the files that you directed to any active printer connected to your computer. The computer and 
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If 
you restore the icon to a window, you see the print queue for any active printer connected to your 
computer. You can use the Print Manager window to check the status of files in the print queue or to 
interrupt or cancel a print job.



luminosity
The brightness of the color on a scale from black to white.



maximize
To enlarge a window to its maximum size by using the Maximize button or the Maximize command.



Maximize button          

The small button at the upper-right corner of a window that contains an Up arrow. Mouse users can click
the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize 
command on the Control menu.



Media Control Interface (MCI)
A standard control interface for multimedia devices and files. MCI allows a multimedia application to 
easily control a variety of multimedia devices and files.



memory
The space in a computer where information is stored while you are working with it. Most PCs have a 
small amount of read-only memory (ROM), containing the built-in programs that start the operation of 
the computer when it is turned on, and a large amount of random-access memory (RAM) for users' 
programs and data.



menu          

A list of available commands in an application window. Menu names appear in the menu bar near the 
top of the window. The Control menu, represented by the Control-menu box at the left end of the title 
bar, is common to all Windows applications. You use a command on a menu by selecting the menu 
name, then choosing the command you want.



menu bar          
The horizontal bar containing the names of an application's menus. It appears just under the title bar.



menu command          

A word or phrase in a menu that you choose to carry out an action, such as copying a file.



menu name
The name for a particular menu that appears in the menu bar and opens a menu when you choose it.



menu title
A word or phrase in the menu bar that identifies a group of commands. Selecting the menu title causes 
the title to be highlighted and its menu of commands to appear below it.



MIDI
Musical Instrument Digital Interface. MIDI sets a communications standard for transferring data between
musical instruments and associated devices.



MIDI file
A file format for storing MIDI songs. In Windows, MIDI files have a .MID filename extension. 



MIDI Mapper
A Control Panel option that lets you create and edit MIDI setup maps. Windows uses these maps to 
translate and redirect MIDI data. 



MIDI Sequencer
Software that creates or plays songs stored as MIDI files. When a sequencer plays MIDI files, it sends 
MIDI data from the file to a MIDI synthesizer that produces the sounds. Windows provides a MIDI 
sequencer to play MIDI files.



MIDI Manufacturer's Association (MMA)
A collective organization composed of MIDI instrument manufacturers and MIDI software companies. 
The MMA works with the MIDI Standards Committee to maintain the MIDI specification. 



minimize
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



Minimize button          

The small button at the upper-right corner of a window that contains a Down arrow. Mouse users can 
click the Minimize button to reduce a window to an icon. Keyboard users can use the Minimize 
command on the Control menu.



movie file
A multimedia data file (for example, a file with the .MMM extension). You can play movie files with the 
Media Player accessory. Movie files are also called animations. 



MSCDEX
Microsoft Compact Disc Extensions. MSCDEX is software that makes CD-ROM drives appear to DOS 
as network drives. You must have MSCDEX installed on your computer for the CD-ROM drive to work. 



multimedia extensions
Additional features added to Windows version 3.0 that enable your computer to run animations, play 
sound and MIDI files, and display high-quality images. 



Multimedia PC
Multimedia personal computer. A multimedia computer satisfies a minimum set of hardware/software 
requirements necessary for multimedia computing. The requirements include:

An 80286/386/486 microprocessor running at 10MHz or faster
2MB or more of RAM
30MB or larger hard disk
VGA display
A digital audio subsystem
A CD-ROM drive
Systems software compatible with Microsoft Windows version 3.0 with multimedia extensions



multitasking
The ability of a single computer to perform several tasks simultaneously.
Multitasking makes it possible to print one document while editing another, or to perform lengthy 
computations while you work on something else.



network printer
A printer that is accessible to your computer only through a network.



network queue
Lists the files on the network server if you are using a network printer.



network server
A computer on a network that provides a particular service to other computers. For example, a disk 
server manages a large file server, and a print server manages a printer.



non-Windows application
An application that was not designed to run in Windows. Generally, non-Windows applications do not 
conform to Windows user-interface standards.



open
To display the contents of a directory or file in a window, or to enlarge an icon to a window.



option button           

A small round button that appears in a dialog box and is used to select an option. Within a group of 
related option buttons, you can select only one button.



palette
Defines the colors used in a bitmap image. Every device independent bitmap (DIB) has an associated 
color palette. 



parity
The method of detecting errors in data transmission.



patch
A specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as patches.



patchmaps
A patch is a specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as 
patches. Patchmaps translate MIDI patch changes to ensure the proper instruments are used to play 
MIDI files. All MIDI files for Windows are authored using standard patch assignments based on the 
General MIDI Mode standard.



pathname
The directions to a directory or file within your system. For example, C:\WINDOWS3\APPTS\JUNE.CAL 
is the pathname of the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on drive 
C.



picture elements
The smallest graphics unit on the screen. Also known as pels.



pixels
The smallest graphic units on the screen. Also known as picture elements (pels).



playlist
A list of compact disc titles and tracks that determines the order in which the tracks on the disc are 
played. Playlists are only used in Music Box.
Use the Program button to assign or edit titles, and to change the playlist.



pointer          
In Windows, the shape of the pointer indicates its function.

For selecting Windows items, scrolling, resizing windows, 
and moving windows and dialog boxes with your mouse. 
This is the pointer you will see most often.

For choosing a HyperGuide hotspot.

For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your 
keyboard.

For indicating the application is processing your request.

port
A connection on a computer where you plug in a cable that carries data to a device.
LPT ports are parallel ports. COM ports are serial ports. EPT is a port used for certain printers, such as 
the IBM Personal Pageprinter. You can use the EPT port only if you have installed a special card in your 
computer.
Multimedia PCs also have a port for a MIDI sequencer.



print options
Printer-specific settings such as page orientation--portrait or landscape--or the manner in which paper 
feeds through the printer. These options vary from printer to printer.



printer-driver file
A file that gives Windows important information about how to control your printer, including details about 
printer features and the printing interface, descriptions of fonts (such as sizes and styles), character 
translations, and control sequences the printer uses to achieve various formats. Windows has printer-
driver files for most commonly used printers.



printer font
A series of dots connected by lines that can be scaled to different sizes. Another name for printer fonts is
vector (or stroke) fonts. Plotters typically use vector fonts.



printer queue information line          

Indicates the following:
The name of the printer.
Where the printer connects to your computer.
The current status of the printer.



program file          

A file that contains information that controls an application. In File Manager, each program file is 
represented by an icon. You can start the application by choosing the icon. Filenames for program files 
can have these extensions: .EXE, .COM, .PIF, and .BAT.



program information file (PIF)
A file that provides important information that Windows needs to run a non-Windows application. PIFs 
contain information such as the name of the file, a startup directory, whether the program writes directly 
to the screen or to memory, and multitasking options for applications running in 386 enhanced mode.



program item          

A program file or associated document represented by an icon in Program Manager. The program item 
provides the instructions Windows needs to start an application and open a document (if specified) when
you choose the icon.



program item icon          

An icon representing an application you can start or an associated document you can open from a group
in Program Manager. The program item provides the instructions Windows needs to start an application 
and open a document (if specified) when you choose the icon.



RGB components
The amount of each of the three primary colors--red, green, and blue--present in a color. Every color and
pattern is made by varying the three primary colors. This is true even in monochrome (black and white) 
mode. For instance, white is made by mixing together 255 parts of red, 255 parts of green, and 255 
parts of blue. Black, on the other hand, is 0 red, 0 green, and 0 blue.



read-only
Describes a file or CD-ROM disc that can only be opened and read. You cannot edit a read-only file or 
CD-ROM disc and save your changes.



real mode
An operating mode that Windows runs in to provide maximum compatibility with versions of Windows 
applications released prior to Windows version 3.0. Real mode is the only mode available for computers 
with less than 1 MB of extended memory.



Restore button          

The small button at the upper-right corner of a window that contains both an Up arrow and a Down 
arrow. The Restore button appears only after you have enlarged a window to its maximum size. Mouse 
users can click the Restore button to return the window to its previous size. Keyboard users can use the 
Restore command on the Control menu.



root directory
The main directory on a disk. The root directory is created at the first level when you format a disk. The 
symbol used to indicate the root directory of a disk is the backslash (\). For example, the root directory 
for drive C is noted as C:\.



sample
A piece of waveform data represented by a single numerical value. You convert sound into digital form 
by taking samples of the sound at specific time intervals and converting them to numeric values.



saturation
The purity of a hue, moving from gray to the pure color.



scaled font size
A font size that approximates a specified font size for use on the screen. Windows scales larger font 
sizes when a size that is available for the printer is not available for the screen. Scaled fonts may look 
slightly different from unscaled fonts. When you choose a smaller font size that is available for the printer
but not for the screen, Windows substitutes the correct size from a precision-drawn font that resembles 
the selected font as closely as possible.



screen font
A font that duplicates a printer font on your screen.

If you choose a printer font that does not have a corresponding screen font, Windows substitutes a 
screen font that closely resembles the printer font. The substitute font duplicates the line lengths and 
page breaks of the font you selected.
When you purchase extra fonts from a printer or font manufacturer, ask about the availability of screen 
fonts to match.



screen saver
An image or pattern that is shown on your computer screen during periods of inactivity. Screen savers 
hide information currently on the screen; by changing patterns they can also save wear on the 
electronics in the display.



scroll arrow          

An arrow on either end of a scroll bar that is used to scroll through the contents of a window or list box. 
Clicking a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls the contents 
continuously.
Scroll arrows also control the playing of media in some applications, such as Media Player and Sound 
Recorder.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.
A scroll bar is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



scroll box          

The square or rectangular box within a scroll bar that indicates your relative position within a document 
or list box. Mouse users can drag the scroll box up or down quickly through long documents.
A scroll box is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



Search button          

Displays the keywords you can use to search for topics. Use this button to look for topics related to a 
keyword.



select
To mark an item by highlighting it with key combinations or with a mouse. Selecting does not initiate an 
action. After selecting an item, you choose the action that affects or involves the item. For example, you 
can select text and then choose the Copy command to copy the text onto the Clipboard.



selection cursor          
The marking device that shows where you are in a window, menu, or dialog box and what you have 
selected. The selection cursor appears as a dotted box around the text in a dialog box option.



serial ports
Ports used by your system, named COM1, COM2, and so on. Serial ports are typically used for 
connecting modems, mouse devices, and some kinds of printers.



shortcut key          

A key or key combination, available for some commands, that you can press to carry out a command 
without first selecting a menu. The shortcut key for a command is listed to the right of the command 
name on the menu.



shrink
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



simple device
Devices, such as audio compact-disc players, that don't have an associated file and can be opened 
without a filename specification.



solid color
A color directly supported by your display.



source directory
The directory containing the file or files you intend to copy or move.



spin box          

A spin box shows one item in a range of possible choices. Clicking the Up or Down arrow to the right of 
the entry lets you "spin" through the available choices until your choice appears in the display rectangle.



standard mode
The normal operating mode for running Windows. This mode provides access to extended memory. In 
standard mode, you can also switch among non-Windows applications.



status bar          
A line of information located at the top or bottom of a window. For example, in a directory window the 
status bar tells how many files are selected, how much disk space they occupy, and the total number of 
files in the directory. In the Directory Tree window, the status bar shows the number of bytes available on
the disk and the total disk capacity. Not all windows have a status bar.



stop bits
The timing unit between characters.
Stop bits are not actually bits; they determine the time between transmitted characters.



synthesizer
An electronic instrument able to make music and sounds by creating its own audio waveforms and 
sending them out to an audio system. A synthesizer can play back MIDI files.



Task List
A window that shows all the applications you have running so you can switch among them. You can 
open the Task List window by choosing Switch To from the Control Menu or by pressing CTRL+ESC.



text box          

A box within a dialog box where you type the information needed to carry out a command. When the 
dialog box appears, the text box may be blank or may contain text.



text file
A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not 
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually 
consists of characters coded from the ASCII character set. 
The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use text files, such as AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI.



title
Another name for a software application written to run on a Multimedia PC. 



title bar          
The horizontal bar at the top of a window that contains the title of the window or dialog box. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize buttons.



topic
The level in the HyperGuide hierarchy at which you see information in the main window. This information
can be in the form of a Quick Look graphic, an explanation of a command, a conceptual overview, a 
procedure, or a table of keys. Information in pop-up windows and contents screens are not considered 
topics.



track
A sequence of sound on a CD disc, which usually corresponds to a song.



Up button          

Moves up one level in the HyperGuide hierarchy.



vector fonts
A series of dots connected by lines that can be scaled to different sizes.



virtual memory
A memory management system used by Windows running in 386 enhanced mode, which allows 
Windows to behave as if there were more memory than is actually present in the sytem. Virtual memory 
equals the amount of free RAM plus the amount of disk space allocated to a swap file that Windows 
uses to simulate additional RAM.



volume label          
The name you give a disk by using the Label command. Disk labels are optional. You see this 
information in File Manager only if you assigned a label to your disk. You can change or add a disk label 
through File Manager.



WAVE format
Microsoft's format for digitized waveform files. These files have a .WAV extension.



waveform
A sound waveform displays variances in air pressure over time. An audio signal waveform displays 
variances in voltage over time.



wildcard characters
Two MS-DOS characters you can substitute for all or part of a file or directory name when you want to 
find similarly-named files or want one command to affect a number of files or directories.
An asterisk (*) substitutes for all characters. A question mark (?) substitutes for a single character.
For example, this entry covers all files with a .DOC extension in the current directory:

*.DOC
And this entry covers everything named with FY, three other characters, and the extension .90:

FY???.90



window
A rectangular area on your screen in which you view an application or document. You can open, close, 
and move windows, and change the size of most windows. You can open several windows on the 
desktop at the same time and you can shrink windows to icons or enlarge them to fill the entire desktop.



window border          
The outside edge of a window. You can lengthen or shorten each border. You can also change the width 
of the border with Control Panel's Desktop command.



Windows application
An application that was designed for Windows and will not run without Windows. All Windows 
applications follow the same conventions for arrangement of menus, style of dialog boxes, use of the 
keyboard and mouse, and so on.



wrap
The automatic movement of the insertion point from the end of one line to the beginning of the next line 
as you type. When text wraps, you do not need to press ENTER at the end of each line in a paragraph.






